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About the Author

After physically destroying three typewriters, Dan Gookin bought his first
computer in 1982 at the urging of the guy in the typewriter repair shop.
Contrary to his prejudices, Dan quickly discovered that computers were
about more than math, and he quickly took to the quirky little devices.

Twenty-five years later, Mr. Gookin has written over 100 books about comput-
ers and high tech and gone through more than 50 computers, including a
dozen or so laptops and portables. He has achieved fame as one of the first
computer radio talk show hosts, the editor of a magazine, a national technol-
ogy spokesman, and an occasional actor on the community theater stage.

Dan still considers himself a writer and computer “guru” whose job it is to
remind everyone that computers are not to be taken too seriously. His
approach to computers is light and humorous, yet very informative. He
knows that the complex beasts are important and can do a great deal to help
people become productive and successful. Dan mixes his vast knowledge of
computers with a unique, dry sense of humor that keeps everyone informed —
and awake. His favorite quote is “Computers are a notoriously dull subject,
but that doesn’t mean I have to write about them that way.”

Dan Gookin’s most recent books are PCs For Dummies, 10th Edition, Laptops
For Dummies, 2nd Edition, and some new titles he can’t yet discuss under
threat of death. He holds a degree in communications/visual arts from UCSD.
Dan dwells in North Idaho, where he enjoys woodworking, music, theater,
riding his bicycle, and spending time with the lads.
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Introduction

A re you nervous? Intimidated? Befuddled and confused beyond all
recourse? What did they do to Word? Just when you thought you finally
had a leg up on the program, just as you finally remembered that the Sort
command is on the Tables menu, they’ve gone and changed . . . everything!
What a headache!

Welcome to Word 2007 For Dummies, which is a better solution to your word
processing pains than taking two aspirin and calling tech support in the
morning. This book is your friendly, informative, and entertaining guide to
the newfangled way of processing words that is Word 2007.

I'm not telling you that this book will make you all cozy and pleased with the
new ways of Word. No, 'm merely promising that this book eases the pain
everyone feels with Word 2007. Let other authors apologize for the program!
I'm here to kick Word in the butt and, hopefully, you’ll enjoy watching that.

What's New in Word 2007?

Earlier versions of Word all looked alike. They had menus, toolbars, task
panes, and other pop-up, drop-down, leak-out nonsense. With Word 2007, all
that stuff is gone, nailed shut in a box and wheeled away into that huge ware-
house where the U.S. government keeps the Ark of the Covenant. Word 2007
sports no menus. It has only one tiny toolbar.

Replacing the menus and toolbars is a tabbed Ribbon system. The tabs are
like the menus of old, but their commands are grouped into graphical com-
mand buttons. Some buttons are commands, some buttons are menus. This
setup can be overwhelming at first, but [ must admit that it makes it possible
to do some tasks in fewer steps than with the old Word interface. Knowing
that, of course, doesn’t make the thing less intimidating.

Beyond the interface, Word is a bit stricter on styles and formatting. The ben-
efit here is instant previews, or the ability to instantly see how changes affect
your document as you browse a menu. Part Il of this book explains more.

Word’s main mode of operation is Print Layout view. If you were a fan of
Normal or Draft view in previous versions of Word, I highly recommend that
you switch to Print Layout view, if you haven’t already.
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Finally, many commands didn’t survive the transition from older versions of
Word to Word 2007. You won’t find any of the following in Word 2007:

AutoFormat Save All

Close All Save As Web Page
Character Animation Speech

File Search Wizards

Frames WordPerfect Help

Office Assistant

These items were either dropped entirely or replaced with something better.

About This Book

[ don’t intend for you to read this book from cover to cover. It’s not a novel,
and if it were, it would be a musical novel and you’d be required to sing the
songs and go through the dances with all the characters in a book and, quite
honestly, I don’t think that the people near you would let you get away with it.

This book is a reference. Each chapter covers a specific topic or task that
Word does. Within a chapter, you find self-contained sections, each of which
describes how to perform a specific task or get something done. Sample sec-
tions you encounter in this book include:

v Saving your stuff

v Moving a block of text

v Quickly finding your place

v~ Aligning paragraphs

v Cobbling a table together quickly

v Creating a table of contents

v Adding topics to your outline
There are no keys to memorize, no secret codes, no tricks, no videos to sleep
through, and no wall charts. Instead, each section explains a topic as though
it’s the first thing you read in this book. Nothing is assumed, and everything
is cross-referenced. Technical terms and topics, when they come up, are
neatly shoved to the side, where you can easily avoid reading them. The idea

here isn’t for you to learn anything. This book’s philosophy is to help you
look it up, figure it out, and get back to work.
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How to Use This Book

You hold in your hands an active book. The topics between this book’s
yellow-and-black covers are all geared toward getting things done in Word
2007. Because nothing is assumed, all you need to do is find the topic that
interests you and read.

Word uses the mouse and keyboard to get things done. Still, the program
looks different from traditional Windows programs, so pay attention!

This is a keyboard shortcut:
Ctrl+P

This shortcut means that you should press and hold the Ctrl (control) key
and type a P, just as you would press Shift+P to get a capital P. Sometimes,
more than two keys need to be pressed at the same time:

Ctrl+Shift+T

In this line, you press Ctrl and Shift together and then press the T key.
Release all three keys.

Commands in Word 2007 exist as command buttons on the Ribbon interface.
This book may refer to the tab, the command group, and then the button
itself to help you locate that command button — for example, the Page
Layout tab, Page Background group, Page Color button. Or, I might say “the
Page Color button found in the Page Layout tab’s Page Background group.

Often times, command buttons are shown in the margin, which can help you
locate them.

Menu commands are listed like this:
Tablec>Insert Table

This command means that you choose the command named Insert Table
from the Table menu. Note that Table is most likely a button on the Ribbon.

The File menu from previous versions of Word now exists as the Microsoft
Office Button menu, which I refer to as the Office Button menu. You still press
Alt+F to access this menu, and it contains items similar to the old File menu.

3
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When I describe a message or something you see on-screen, it looks like this:

Why should I bother to learn about compound interest when
robots will eventually destroy the human race?

If you need further help operating your computer or a good general reference,
I can recommend my book PCs For Dummies, published by Wiley Publishing,
Inc. The book contains lots of useful information to supplement what you find
in this book.

Foolish Assumptions

Though this book was written with the beginner in mind, I still make a

few assumptions. Foremost, | assume that you're using a computer. You

use Windows as the computer’s operating system, either Windows Vista

or Windows XP or any other version of Windows that can run Word 2007.
There are no specific issues between Word and Windows as far as this book
is concerned, but keep in mind that this book isn’t about Windows.

Your word processor is Microsoft Word 2007. It is not Microsoft Works. It is
not an earlier version of Word. It is not WordPerfect. It is not a version of
Word that runs on a Macintosh.

Throughout this book, I use “Word 2007” and “Word” interchangeably. Both
refer to the same thing. (Word 2007 may also be referred to as Word 12 in
some instances, although not in this book.)

Word 2007 is a part of the Microsoft Office 2007 suite of programs. This book
doesn’t cover any other part of Microsoft Office, nor do [ assume that you
even have the Microsoft Office suite installed.

How This Book Is Organized

This book contains six major parts, each of which is divided into several chap-
ters. The chapters themselves have been sliced into smaller, modular sections.
You can pick up the book and read any section without necessarily knowing
what has already been covered in the rest of the book. Start anywhere.

Here’s a breakdown of the parts and what you can find in them:
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Part I: Hello, Word!

This part provides a quick introduction to Word and word processing.
Information is offered on how best to use your keyboard, plus a simple
overview of the typical word processing day. Part I contains lots of good,
basic information.

Part II: Word Processing Basics

The chapters in this part of the book cover the 7 basic tasks of any word
processor: moving around a document, editing text, search and replace,
working with blocks of text, document proofing, saving and opening, and
finally printing.

Part 11]: Formatting

This part deals with formatting, from the smallest iota of text to formatting
commands that span an entire document and more. Formatting is the art of
making your document look less ugly.

Part IV: Making Your Document
All Fancy-Schmancy

This part is formatting dessert, or things you can do beyond regular format-
ting to help make your document look like more than a typical, boring docu-
ment. It covers lines, borders, tables, columns, lists, graphical goodness, and
all sorts of stuff that makes Word more than a typical word processor.

Part U: What Else Is Left?

This part covers a few dangling details that I consider myself fortunate to
write about, such as outlining, collaboration, mail merge, label-making, and
other interesting things that Word does.

Part Ul: The Part of Tens

The traditional last part of any For Dummies book contains chapters with lists
of ten items. You'll find lots of helpful stuff here, some weird things you may
not know about, plus even more useful tips, tricks, and good suggestions.
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What's Not Here

Word is one heck of a program. Covering the entire thing would take a book
several thousand pages long. (I kid you not.) My approach in this book is to
cover as much basic word processing as possible. Because of that, some
advanced features did get pushed off the table of contents.

You won'’t find any information here on macros in Word. Although they can be
useful, it’s tough to get into macros without broaching the more technical topic
of Microsoft Office Visual Basic, which is a true programming language —
definitely not beginner stuff.

Some of the more esoteric features are touched upon lightly here. For exam-
ple, I could spend about 70 pages detailing what can be done with graphics in
Word, but I limited myself to only a dozen pages.

Finally, this book doesn’t cover using Word to do anything on the Internet.
That includes using e-mail, making a Web page, blogging, online publishing,
creating forms, or doing that kind of stuff. This is a word processing book,
and Word is a word processor.

Icons Used in This Book

A\

This icon flags useful, helpful tips or shortcuts.

This icon marks a friendly reminder to do something.

This icon marks a friendly reminder not to do something.

This icon alerts you to overly nerdy information and technical discussions of
the topic at hand. The information is optional reading, but it may enhance
your reputation at cocktail parties if you repeat it.
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Where to Go from Here

Start reading! Observe the table of contents and find something that interests
you. Or, look up your puzzle in the index.

Because Word 2007 has changed, whether you’re new to the program or not,
you should start reading at Chapter 1.

Read! Write! Let your brilliance shine on a sheet of paper.

My e-mail address is dgookin@wambooli . com. Yes, that’s my real address. |
try to reply to all the e-mail I get, although sometimes I'm not that speedy.
And, although I enjoy saying “Hi” or answering questions about this book,
please do not e-mail me with technical support questions or problems with
your computer. For that, I can recommend reading my book Troubleshooting
Your PC For Dummies (Wiley).

You can also visit my Web page for more information or as a diversion:
www . wambooli . com. Be sure to check out the Wambooli Forums while

you're there.

Enjoy the book. And enjoy Word. Or at least tolerate it.
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